
Supplementary 
Documents 

Accent Devices 

support@liberator.net.au | liberator.net.au | 02 9124 9945

1

mailto:info@liberator.net.au
http://www.liberator.net.au/


Some useful tips for the Accent device 

1. Shut down and charge your device every night.
o  Settings - Shutdown

2. Maintain battery charge levels above 25% all the time.
o  Settings - Toolbox - Maint Menu - Battery Menu

3. Put device to sleep when not in use.

4. Back up your vocabulary files and data files regularly to      avoid any loss.
o Insert USB - Toolbox - Transfer memory menu - save one user area - select ‘current area’ - choose

different folder - select USB - name file -  press ‘ok’ 

5. Contact Liberator immediately for technical support on 02 9124 9945. We welcome all your questions.
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Accent 800, 1000 & 1400 Quick 
Reference Guide 

Applies to Software Version 2.06 or 
higher Liberator Support: (02) 9124 9945 
support@liberator.net.au 
liberator.net.au 

Power/Sleep button 

Tools key 
(On the display) 

Tools key (on front of device) 

Most of the operations covered on this guide pertain to all 

language systems: Unity®, UNIDAD®, LAMP Words for Life®, 

CoreScanner™, WordPower™, and Essence®. Exceptions are 

noted. 

Tools Key (pictured above) 
The Tools key reveals a set of User Keys, , such 

as the Toolbox, Shutdown and Setup key. The 

Toolbox and Setup keys are commonly used. 

POWER/SLEEP BUTTON 
The power/sleep button is on the top of the device. 

1. To power on the device, press and hold the power/sleep

button.

2. To wake/sleep the device, press the power/sleep button.

3. The device should be restarted weekly. * 

4. To restart, select Tools, Toolbox, Maintenance Menu, Power
Management, Restart, and then Yes.

* Recommended: Restart once per week; put to sleep daily. 
The device may wake up from sleep if using NuEye or if 
Windows updates are set to install automatically. To 
preserve the charge overnight, either connect the charger or 
shut down the device completely. See step 5. 

5. If you don’t plan to use the device, want to store/transport it

in a bag or receive an error message, it is recommended to

shut down the device completely. To do this, select Tools,

Shutdown, and then Yes.

CHANGING USER AREAS 
1. Select Tools, and then Toolbox. 

2. Select User Area Menu. Select Switch User Area.

3. Select the User Area (1-6) to switch to and wait until the

device returns you to the User Area Menu screen. Select OK.

4. From the toolbox, press Go to Home (blue key).

5. Please note that Replace User Area provides more user area

choices and will overwrite an existing user area. 

CHANGING THE VOICE 
1. Select Tools, and then Toolbox. 

2. Select Speech Menu. 

3. Select Change Voice. 

4. Select the desired voice. Wait for it to load. To listen to the

voice, select Test Speech.

5. Use the additional keys to adjust the pitch, rate, etc. of the

voice. Select OK and Go to Home.

PRONUNCIATION DICTIONARY 
“Teach” the device to pronounce a word correctly. 

1. Select Tools, and then Toolbox. 

2. Select Pronunciation Dictionary.

3. Choose either Main Voice or Prompt Voice. 

4. Select Add Pronunciation. 

5. Enter the correct spelling of the word. Select OK.

6. Enter the “phonetic spelling” of the word. To test the 

pronunciation, select the message window. 

7. Select OK, and then OK.

8. From the toolbox, press Go to Home (blue key).

DISABLING THE TOOLBOX 
To disable the toolbox: 
1. Select Tools, and then Toolbox. 

2. Select Maintenance Menu. 
3. Select Disable Toolbox and select Disable under Toolbox.

You must enter a password and select OK to disable the

toolbox.

4. Remember your password. (see “Create Toolbox Disable

Override” below) 

5. Select OK, OK, and then Go to Home (blue key).

To enable the toolbox:
1. Select Tools.
2. Enter your password and select OK.

3. Select Toolbox. 
4. Select Maintenance Menu. 
5. Select Disable Toolbox and select Enable under Toolbox.

6. Select OK, OK, and then Go to Home (blue key).

Additional options

1. Select Tools, Toolbox, Maintenance Menu, and Disable
Toolbox.

2. Create Toolbox Disable Override: Select this option and then

insert a USB flash drive. An override file will be placed on the

flash drive. Select OK. The device will “unlock” anytime this

USB flash drive is inserted into the device (without the need

to enter a password).

3. Enable or Disable On-Screen Tools Key, Help Button, and/or 

Pulldown Menu Button.

MODIFY USER KEYS 
The user keys appear after you select the Tools key. 

1. Select Tools, and then Toolbox. 

2. Select User Area Menu. 

3. Select Modify User Keys. 

4. Select the key you want to modify.

5. Select Enter Assignment, Clear Display, and then Insert Tool. 
6. Select the tool you want to insert. Select OK.

7. To change the icon and label, select Change Icon and Change 
Label.

8. Select OK, OK, and then Go to Home (blue key).

Note: Select Clear Key Contents if you want no tool assigned

to a User Key.

 
3

mailto:info@liberator.net.au
http://www.liberator.net.au/
http://www.youtube.com/user/PRCaccess/playlists


TEMPORARILY LIMITING VOCABULARY 
There are two ways to temporarily limit the number of words 

appearing on the screen. For example, you only want 8 words 

when first introducing the device to a child. 

1. HIDING/SHOWING KEYS
Use hide/show on a page or in a Unity 1-hit vocabulary. 

1. Select Tools, and then select Setup Key. 

2. Select Hide/Show Keys at the top right corner of the screen. 

3. Select the keys to hide or select Hide All. 
4. If you selected Hide All, select individual keys to “show” by 

touching them. They brighten. 

5. Select the text display area to exit.

6. To show all keys, select Show All after step 2. 

2. VOCABULARY BUILDER
Use Vocabulary Builder on a Sequenced or Full vocabulary (such as 

Unity 60 Sequenced or LAMP WFL Full). 

For Unity: Video and Quick Reference Guide 

For LAMP WFL: Video and Quick Reference Guide 

EDITING A KEY 
1. Be sure you are looking at the key you want to edit. Select

Tools, and then Setup Key.

2. Touch the key you want to edit.

3. Select Change Icon. Then do one of the following:

A. Spell Icon to Find. Spell what you are looking for. Select 

OK. Touch the icon you want.  B.
Plug a USB flash drive with photos on it into the device.

Select Import Icon. If the content of the flash drive is

showing, touch the photo you want to import. If not, select

Up Folder to navigate to the flash drive, and then touch the

photo you want. Select OK and OK. Select Cancel. The photo

will be placed on the key and in the imports folder of the

icon dictionary. C.
Search for an icon by category.

4. Look to see if the “text to speak” is correct. If not, select 

Spell Message or Define Key Function to type text that will

appear in the display and be spoken. Be sure to put a space

after the last character. Select OK.

5. Check to see if the label is correct. If not, select Change
Label, type new label and OK.

6. Select OK or Choose Next Key to Define. 

TAKING A PHOTO 
1. Select Tools, and then Toolbox. 

2. Select Camera Menu. 

3. Frame the picture. Select Take Picture. 

4. Do either of the following (most common B. Save as Icon): 
A. Select Save as Scene to use this photo for a visual scene

that spans multiple keys. Select Rename Scene, and then

select Clear Display. Type a name, select OK, OK.
B. Select Save as Icon to use this photo for an icon on a

single key. Select Rename Icon and then select Clear Display.

Type a name and select OK. Select OK again. The photo will

automatically be placed in the Imports folder. Note: When

changing an icon, your photos will be in the category called

Imports.

5. Select OK and then select Go to Home. 

CREATING A NEW ACTIVITY 
(Unity language system ONLY) 
1. Select Tools, and then Toolbox. 

2. Select Create Activity.

3. Spell the name of the new activity. Select OK.

4. Select an icon for the activity.

5. Touch a blank key in the activity. A red box will appear

around the key. 

6. Select Change Icon to search for an icon.

7. Select Spell Message or Define Key Function to type text that will 

appear and be spoken in the display, be sure to put a space after 

the last character. Select OK. 

8. Change Label if needed. Select OK.

9. When finished, select OK (or touch the next key to be set 

up). Go to Home (blue key).

HIDING ACTIVITIES 
(Unity language system ONLY) 
1. Select Tools, then Setup Key. 

2. Select the activity you wish to “hide”. 

3. Choose Hide on the right side of this screen.

4. If you don’t see the activity you need, scroll through by 

selecting More Items.

5. When you are finished, select OK.

CREATING and LINKING PAGES 
1. Be looking at the key that will link to the new page. Select

Tools, then Setup Key.

2. Select the key that will link to the new page. 

3. Select Change Icon to search for an icon.

4. Select Spell Message or Define Key Function. 

5. Select Clear Display. Select Page Link.

6. Decide if you want your page to automatically close after a

key is selected (“close”) or remain open (“open”). 

A. Find and select the page you want to link if it is

already created.

B. If the page is not already created, select Create New
Page, type the name of the page, and select OK. Choose

a keyboard size (to format a new page like an already

existing page, select Create Page from Template).

Select OK.

7. Select Change Label to change the label. Labels for page links

are typically in all CAPS in Unity.

8. Select OK.

VOCABULARY BACK UP 
1. Insert your flash drive into a USB port.

2. Select Tools, and then Toolbox. 

3. Select Transfer Memory Menu. 

4. Select Save One User Area and then the user area you want

to back up or Save Entire Device Contents.

5. Make sure the pre-set folder is a USB drive. If so, select OK. If

not, select Choose different folder and navigate to the USB

drive. Then select OK. Type the file name and date (xx-xx-xx).

6. Select OK and wait for the memory transfer to complete.

Select OK, OK, and then Go to Home.

7. To load in a backup file:

a. Follow steps 1-3 and then choose Load One User Area or 

Load Entire Device Contents. This process will replace

what currently exists in the user area or entire device.

b. If loading one user area, choose a user area to load into.

c. Select the backup file on the USB drive.

d. Wait for the memory transfer to complete. Select OK.

e. If asked “Switch to this User Area now?” answer yes or 

no. Then OK and OK.

INTERNET SOFTWARE UPDATES * 
1. The device must be connected to a Wi-Fi network. 

2. Select Tools, and then Toolbox. 

3. Select Maintenance Menu, and then Software Update
Menu.

4. Select Internet Update and follow the prompts.

* Internet updates only apply to versions 1.08 and higher.
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Unity® Vocabulary 
Quick Reference Guide 
 

Find your states consultant at: 
liberator.net.au

Unity 
…is a way to organize the English language that is unique to 

PRC devices. It is primarily based on the single words we say 

most often. It grows from early first words to adult 

language. It has two versions: 1-hit and Sequenced. 

4/8/15/28/36/45/60/84/144 
The numbers refer to the number of keys that are on the 

screen. Don’t assume that versions with fewer keys on the 

home screen are easier. Work with a speech pathologist, 

AAC Specialist, and/or PRC Regional Consultant to help you 

decide where to start. 

Core Vocabulary 
These are words that are most commonly used in English— 

they are used regardless of situation, communication 

partner, or age/ disability of the communicator. Core 

vocabulary lets individuals get their message across. 

Core Keys 
In Unity 28/36/45 1-hit or Sequenced, the entire home 

screen is core with a few exceptions. In Unity 60/84/144 1- 

hit or Sequenced, everything but the top row is core. 

Fringe Vocabulary 
Generally, consists of nouns that are used less frequently 

and vary according to a situation. Fringe words might be 

different when we are talking about a basketball game than 

when we are doing an art project. Fringe vocabulary is 

found in the activity row. 

Activity Row 
In Unity 28/36/45 1-hit or Sequenced, the activity row (top 

row) appears after you select a core key. It houses nouns. 

In Unity 60/84/144 1-hit or Sequenced, the activity row (top 

row) appears on the home screen as well as after you select a 

core key. Home screen activities house quick phrases and 

tools. Fringe words appear after you select a core key. 

Unity 4/8/15*/28/36/45/60/84/144 1-hit 
The core keys in these vocabularies speak immediately 

when selected, and the activity row changes to nouns/ 

words that may follow that core word. The only word 

ending is plural “s”. This vocabulary can be simplified by 

using hide and show. 

* There is an extra area called 15 phrase. It is for simple phrase- 

based communication. 

Unity 28/36/45/60/84/144 Sequenced 
The core keys in these vocabularies do not speak 

immediately when selected, but rather lead to other words 

associated with that icon. Thousands of words are pre- 

programmed, and all word endings are represented. This is 

a robust vocabulary that gives access to adult forms of 

grammar. This vocabulary can be greatly simplified (using 

Vocabulary Builder) for beginning communicators. 

VISUALIZING UNITY SEQUENCED 
(Examples from Unity 84 Sequenced – the most popular version) 

1. Unity Sequenced is organized in layers. The top

layer is always the starting point. This allows for

the pattern of a word to remain consistent.

2. The top layer has several high-frequency words

that can be said with 1-hit, indicated by lower case

labels on the keys. In 84, these are:

are/is/were/was/on/to/a/an/the.

3. The +s key adds an “s/es” to the end of the last 

word on the display (e.g., for plurals).

4. The KEYBOARD key goes to a keyboard for spelling

your thoughts. 

UNITY PATTERN #1: VERBS, ADJECTIVES, CATEGORY 
NOUNS 

1. Start with any colored icon in the Core area (e.g.,

APPLE). When you select it, get more words

associated with that icon (in this case, words

related to eating: eat, hungry, food).

2. Colors are important on the 2nd layer.

a. GREEN = verb

b. BLUE = adjective

c. ORANGE = category noun

3. Placement is also important on the 2nd layer. Try

another icon (e.g., JUICE), and notice the verbs, 

adjectives, and category nouns are always in the

same place (drink, thirsty, beverage).

4. Usually there is a 3rd layer. There are additional

verbs, adjectives, and nouns associated with the

core icon. For example, the words bite, chew,

taste, feed, delicious, crunchy and fresh are also

associated with the APPLE. You can tell there is a

3rd layer because the 2nd key is grey with a label in

all caps.

 

TIP: You can search for a word using WORD FINDER.

Word Finder is located in different places depending on the 

version of Unity you are using. It will either be in the top 

row , on the keyboard or in pages .

Select . Type the word you want to find. Select OK.

Select Guide Me. If the word is not in Unity, it will tell you 

“No matches found”. 

TIP: Please do not think someone has to graduate

through the levels of Unity. Beginning communicators 

can start at Unity 84 Sequenced and use Vocabulary 

Builder to initially limit the number of words available. 

TIP:

Learn: Register for a variety of live online AAC 
implementation classes at… 
www.prentrom.com/training/go/implementation_classes 

Teach: Find a vast library of therapy materials at… 
www.AACLanguageLab.com 

Accelerate: Monitor progress and language growth… 

www.realizelanguage.com 
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UNITY PATTERN #2: NOUNS 
Nouns are found in the activity row (top row) after you 

select a core icon. 

drinks 

TV 

dishes/ large 

appliances 

furniture/linens 

UNITY PATTERN #3: PRONOUNS (are yellow) 

1. Subject pronouns (e.g., I/ you/ it): Select the

corresponding yellow pronoun 2 times. 

2. Object pronouns (e.g., me/ him/ them): Select the

pronoun key then the present. 

3. Possessive adjectives (e.g., my/ his/ their): Select

the pronoun key then nametag. 

4. Reflexive pronoun (e.g., myself/ himself/

themselves): Select the present then pronoun. 

5. Possessive pronoun (e.g., mine/ his/ theirs): Select

the nametag then the pronoun. 

UNITY PATTERN #4: PRONOUN PHRASES 
1. Positive pronoun statements: Select the pronoun

key and then the phrase to the right. 

I can: 

You like: 

2. Negative pronoun statements: Select the

pronoun key, then NOT, and then the negative

phrase. 

I can’t: 

You don’t like: 

3. Pronoun questions: Start with the corresponding

core icon and then move to the left to get the

pronoun question.

Can I: 

Do you like: 

4. Negative pronoun questions: Start with the

corresponding core icon, then NOT, and then

the pronoun. 

Can’t I: 

Don’t you like: 

UNITY PATTERN #5: GRAMMAR WORDS (Interjections, 
Determiners, Conjunctions, Prepositions, Question 
Words, Adverbs) 
These words start with the black and white icons in the 2nd

row. 

1. HELPING VERBS: Start with . These words 

help a main verb. Words like can/ will/ should. 

2. INTERJECTIONS: Start with . These words

pop into conversation like fireworks pop into the

sky. Words like awesome/ yuck/ hello.

3. DETERMINERS: Start with . The wizard is

using his wand to point to this/ that/ these/ those.

4. CONJUNCTIONS: Start with . Conjunctions 

join words together like the trains are joined 

together. Words like and/ but/ because. 

5. PREPOSITIONS: Start with . The cloud can 

go over/ under/ through the bridge. 

6. QUESTION WORDS: Start with . Words like 

who/ what/ when/ where/ why.

7. ADVERBS: Start with . Words like very/ 

again/ ready.

 

sentences 

school 

games 

jokes 

jobs/tools 

money 

feelings/actors 

reading material 

instruments /music 

sports 

family/people 

animals 

time 

accessories 

places 

nature 

colors/art supplies 

body parts/ 

toiletries 

technology 

rooms 

medical 

vehicles 

toys/containers 

clothes 

food 

computer 

holidays/shapes 

weather/negative 
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Vocabulary Builder (VB) for Unity 
Quick Reference Guide 
Software version 2.08 or higher 

Find your local consultant:
liberator.net.au 

support@liberator.net.au 

TURN VOCABULARY BUILDER ON/OFF 

1. Select Tools . 

2. Select Vocabulary Builder. 

3. Select Vocab Masking ON or Show All Words (OFF).

When Vocabulary Builder is turned ON,  will 

appear in the status area. 

Select Show All Words to quickly bring back all vocabulary. 

For example, to have words for bubbles and cars at the 

same time, first load the bubbles set, and then merge in 

the cars set. Merge always adds to your existing set. 

BUILD YOUR OWN SET 
With this method you are combing pre-made sets to make 

your own unique set. 

1. Select Tools . 

2. Select Vocabulary Builder. 

3. Select Build Your Own.

4. Select a set of words. For example, First Words 50.

5. Then add additional sets of words (for example from

categories—foods, animals, and colors) by selecting

Tools, Vocabulary Builder, Build Your Own, and

User Keys 

Toolbox 

Setup key 

Vocabulary Builder 

ACTIVITY SETS 
Select an activity to temporarily limit the vocabulary to a 

set of words related to that activity. Each set contains a 

variety of parts of speech such as verbs, adjectives, 

prepositions, and interjections. The words in each set 

allow an individual to request the activity, talk during that 

activity, and end it. The activities are broken up into three 

categories: At Play, At Home and At School. 

Typically, someone cannot speak throughout a day with 

Merge Set . Then select the set to merge. Repeat 

this step for every set you would like to merge. 

6. When complete, see Saving a Set on page 2.

SPELL TO MAKE A SET

1. Select Tools . 

2. Select Vocabulary Builder. 

3. Select the Spell to Make a Set. 
A. If you are not currently using VB, select Mask All.
B. If you are currently using VB and want to add a few

more words, go to step 4. 
To access the User Keys above, select Tools in the 

top right-hand corner of the screen. 

Unity is a way to organize vocabulary and language on PRC 

devices. It was created to both follow and enable language 

development. 

Vocabulary Builder is a therapeutic tool designed to teach 

new vocabulary within Unity 28, 36, 45, 60, and 84 
Sequenced. The strategy of masking vocabulary allows 

support staff to teach a small amount of vocabulary on the 

device while keeping learned motor plans constant. 

VB ON 

VB OFF 

words from a single activity set. Use these sets as a 

starting point. 

To change to a different set: 

1. Select Tools . 

2. Select Vocabulary Builder. 

3. Select your desired set. 

To add another set of words to an existing set: 

1. Select Tools . 

2. Select Vocabulary Builder. 

3. Select the category of the set you would like to

merge—At play, At home or At school.

4. Select Merge Activity Set . 

5. Select your desired activity to merge. 

4. Make sure the list to the right is tan by tapping it.

5. Select Spell to Unmask. 

6. Type word(s) to unmask using commas to separate the

words.

7. Select OK when finished. 

8. On the left-hand side are all of the words that will be

available. There may be some words that are listed

twice. That is because the word is stored in different 

locations. If so, you can remove an unwanted

sequence by selecting it and then select Mask.

9. When finished select OK.
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MASKING ON THE FLY (MOTF) 
MOTF is another way to quickly make a set of words. Use 

this method if you know where the word(s) is located in 

Unity. Select icon sequences to unmask words. 

1. Select Tools . 

2. Select Vocabulary Builder. 

3. Select MOTF . 

A. If you are not currently using VB, select Mask All.
B. If you are currently using VB and want to add a few

more words, go to step 4. 

4. Select the sequence(s) needed for the word(s) you

wish to unmask. For example: 

5. Select the text area (grey bar at the top) to exit.

MOTF – USING THE NAVIGATE FUNCTION 
Use the Navigate function to unmask words in activity 

subcategories (for example, foods—fruit) or to make the 

function on a key active (for example, Go Back, More). 

1. Follow the example below to navigate into

subcategories to select a word such as “banana”: 

a. Once in Masking on the Fly, select the apple from

the core area, and then select the subcategory

Fruit.

b. Select Navigate and touch the Fruit category

again. 

c. Select banana. 

2. Either continue unmasking more vocabulary or select

the text area (grey bar at the top) to exit.

SAVING A SET 
1. Have your desired set created and in use. 

2. Select Tools . 

3. Select Vocabulary Builder. 

4. Select Build Your Own.

5. Select Save My Set. Type a name for your set.

6. Select OK twice.

LOADING A SET 

1. Select Tools . 

2. Select Vocabulary Builder. 

3. Select Build Your Own.

4. Select Load My Set. Select the set to load.

5. Select OK twice.

Additional TIPS! 

MERGE WORD FINDER 
To add Word Finder to any set, simply select Merge Word 
Finder. 

MERGE KEYBOARD 
To add a keyboard for spelling to any set, simply select 

Merge Keyboard. 

ACTIVE SIDE WHEN SPELLING 
When changing between spelling and MOTF, or when 

adding additional words to an existing set, you may notice 

the tan background changes sides. Be sure the list you are 

searching always has the tan background. Touch the side 

to make it tan/active. 

INCLUDING ALL PHRASES 

When the set contains some pronouns and some preverbs 

(I, you, want, like), the Include All Phrases button will 

automatically capture any phrases that can be made from 

the words selected.

 

TIP:

Learn: Register for a variety of live online AAC 
implementation classes at… 
www.prentrom.com/training/go/implementation_classes 

Teach: Find a vast library of therapy materials at… 
www.AACLanguageLab.com 

Accelerate: Monitor progress and language growth… 

www.realizelanguage.com 

TAN=Active Side 
Search for words depends 

on side that is active or tan. 
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LAMP Words for Life™ (WFL) Vocabulary Quick 
Reference Guide 
Liberator device support: www.liberator.net.au 
LAMP Approach Training: www.aacandautism.com 

Terms you need to know: 

Core Vocabulary – Words that are most commonly used 

in English – they are used regardless of situation, 

communication partner, or age/ disability of the 

communicator. Individuals must have access to core 

vocabulary in order to get their message across! 

Fringe Vocabulary – Generally nouns that vary according 

to the situation. Fringe words might be different if we are 

talking about a basketball game versus doing an art project. 

They might also be different from communicator to 

communicator. 

LAMP Words for Life Vocabulary Files 
A vocabulary level DOES NOT need to be mastered 

before transitioning to the next vocabulary level. The 

decision on where to start will be influenced by factors 

such as ability to attend to sequenced steps, need for 

immediate reinforcement, and access to vocabulary. 

Always start at the highest level where the user 

demonstrates a moderate level of success. 

One-Hit – 82 pre-stored words that require selecting one 

button to hear the word. Also, includes “mom” and “dad” 

which are routinely used by beginning communicators, but 

require selecting two buttons before the word is spoken. 

Transition – 205 frequently occurring words. Offers more 

vocabulary and introduces verb tensing. Most words 

require selecting two buttons before a word is spoken; 

however, these motor patterns are easy to follow. 

Full – Access to thousands of words by selecting three or 

less buttons offers robust vocabulary and full grammar. 

Guiding principles of LAMP WFL language system: 
1. A word-based program. A priority is placed on

core vocabulary with access to fringe.

2. One motor plan per word allows for the

development of quick effortless communication.

No repeating words based on category;

homonyms not present until the full level.

3. No motor plan changes as language develops.

Motor plans can grow but not change.

4. At the LAMP 84 full level, EVERY word can be

accessed in 3 hits or less.

5. At the full level, the initial core word appears as

a label on the first button.

6. No carrier phrases – You do not have to hear a

word to get a word

7. First 4-5 spaces on the second row are empty in

the transition and full levels. Storing personalized

words here allows for the motor plan for these

words to remain constant across levels.

8. No triple hits on one icon. No double hits on an

icon before going to a third icon.

Organizational Structure: 
LAMP WFL is based on Unity®, the language system in 

PRC devices. However, there are some differences 

based on LAMP principles. The rules governing the 

language structure are for the benefit of the individual 

teaching the language. We recommend that words be 

taught by emphasizing the motor pattern. The basic 

structure is described below: 

1. LAMP WFL is organized in layers. The top layer

or home screen is always the starting point. This

allows for the pattern of a given word to remain

consistent.

2. The home screen of LAMP WFL has several

high-frequency words that can be said with 1-

hit. These are: a/is/were/was/to/an/the.

3. The +s button adds an “s” to the end of a word to

make it plural.

4. The SPELL/NUM key goes to a keyboard.

 

TIP: Vocabulary Builder™ is an excellent tool to temporarily 

limit the number of words available on the display. It allows 

an individual to focus on a small set of target words while 

maintaining consistent motor patterns for those words. Use 

it during teaching moments, but remember to allow ample 

time for access to all vocabulary for independent 

exploration and learning! 
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VERBS, ADJECTIVES, CATEGORY NOUNS 
1. Select any icon on the home screen (for

example, eat). When selected, you gain access

to another layer with words related to that icon

(in this case, words related to eating such as

“eat,” “hungry”, and “food”).

2. Colors are important!

a. GREEN = verb

b. BLUE = adjective

c. ORANGE = category noun

d. YELLOW = pronouns

3. Placement is important in the 2
nd 

layer! Try

another icon (for example, play), and notice the

verbs, adjectives, and category nouns are color- 

coded and always end in the same place.

4. Sometimes there will be a 3
rd 

layer. After you

push “eat”, you not only see the word “eat” at

the verb location, you also see “GROW,” “BITE,”

and “CHEW.” You can tell there is a third layer

because the 2
nd 

button is in all caps. Choosing

one of these buttons will take you to a third

layer with forms of that word.

PRONOUNS 

1. Pronouns can be found on the left-hand side of

the screen.

2. Pronouns are color-coded yellow.

3. At the full level, you have the option to

reduce keystrokes by using pronoun phrases.

To follow the LAMP approach, we recommend that 

pronoun phrases not be used until the person can access 

each word individually, particularly if there are auditory 

processing concerns. So initially, instead of teaching the 

phrase “I want,” teach each word separately “I” + “want”. 

GRAMMAR WORDS (Interjections, 
Determiners, Conjunctions, Prepositions, 
Question Words, Adverbs) 
These words start with the black and white icons on the 

2
nd 

row. 

1. INTERJECTIONS: Start with . These words

pop into conversation like fireworks pop into the

sky (for example, awesome/ yuk/ hello).

2. DETERMINERS: Start with . The wizard is using 

his wand to point to “this/ that/ those/ these”. 

3. CONJUNCTIONS: Start with . Conjunctions join

words together like the trains are joined together (it

also gives us some quick access to numbers/ math

words) – for example, and/ but/ because.

4. PREPOSITIONS: Start with . The cloud can 

go over/ under/ through the bridge. 

5. QUESTION WORDS: Start with . Words 

like who/ what/ when/ where/ why.

6. ADVERBS: Start with . Words like very/ 

ever/ ready.

NOUNS 
Nouns are typically found in the top two rows after 

pushing an icon on the home screen. In the transition 

and full vocabularies, the first four to five buttons on the 

second row are blank. These buttons are for storing 

favorite items. If a word is stored in the transition level, 

it should be stored in the same location in the full level 

to maintain consistent motor patterns. 

 

names 

body parts 

clothing 

subjects/grades 

games/ toys 

jobs/ tools 

money 

feelings 

things you read 

music players 

sports 

family 

animals 

time 

stores/community 

nature/ places 

colors/art supplies 

toiletries/sick 

rooms/ buildings 

people 

vehicles 

food 

holidays/shapes 

weather 

drinks 

TV 

dishes/appliances 

furniture/ linens 

TIP: Search for a word using WORD FINDER. Type a 

word and it will show you how to say it in LAMP WFL. 
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LAMP Vocabularies Reference Guide 

THINGS TO KNOW: 
OK will save menu changes; 

Cancel will escape out of menus; 

Go to Home in toolbox will exit 

to the vocabulary. 

POWER/SLEEPBUTTONS 
1. To power on the device, press and hold the button. 

2. To wake the device from sleep mode, press power/sleep 

button.

3. The device should be restarted weekly. *To restart, select 

Tools, Toolbox, Main Menu, Power Management, 
Restart, Yes. 

*Recommended: restart once per week; put to sleep daily or if storing
for extended period shut down the device: Tools, Shutdown, Yes. 

LOADING LAMP WORDS FOR LIFE VOCABULARIES 
1. Select Tools>Toolbox>User Area Menu. 

2. Select Replace User Area and select the area to

replace. NOTE: replacing a user area will 

OVERWRITE the existing area. Be sure the area is 

saved, if there is content you don’t want to lose!

3. Select Pre‐defined Vocabularies>English>LAMP WFL. 
4. Select either 1‐Hit, Transition, or Full and answer YES. 

5. Type the word replace and select OK. Answer YES if
prompted to switch to this user area. 

6. Select OK through the menus to access vocabulary. 

CHANGING THE VOICE 
1. Select Tools>Toolbox>Speech Menu. 

2. Select Change Voice. 

3. Select the desired voice. Wait for it to load. To listen 

to the voice, select Test Speech.

4. Adjust rate, volume, bass, treble, as needed. 

PRONUNCIATIONDICTIONARY 
“Teach” the device to pronounce a word correctly. 

1. Select Tools>Toolbox>Pronunciation Dictionary. 

2. Choose Main Voice. 

3. Select Add Pronunciation. 

4. Enter the correct spelling of the word. Select OK.

5. Enter the “phonetic spelling” of the word. To test the 

pronunciation, touch the message window. Select OK. 

VOCABULARY BACK UP 
1. Insert USB flash drive into USB port. 

2. Select Tools>Toolbox>Transfer Memory Menu. 

3. Select Save One User Area followed by the area you want 

to save or Save Entire Device Contents.

4. Make sure the pre‐set folder is the USB drive and select 

OK. If not, select Choose Different Folder and navigate to 

the USB drive. Select OK and type the name for the file.

5. Select OK and wait for the transfer. Select OK when 

finished. 

DISABLING THE TOOLBOX 
To disable the toolbox: 

1. Select Tools>Toolbox>Maintenance Menu. 
2. Select Disable Toolbox and “Disable” under Toolbox.

Enter a password and select OK to disable the toolbox.

3. Remember your password. (See “Create Toolbox 

Disable Override” below). 

To enable the toolbox: 
1. Select Tools. 
2. Enter your password and select OK. 

3. Select Toolbox. 
4. Select Maintenance Menu. 
5. Select Disable Toolbox and Enable under Toolbox. 

Additional Options: 
1. Select Tools, Toolbox, Maintenance Menu, and Disable 

Toolbox.

2. Create Toolbox Disable Override: Select this option 

and then insert a USB flash drive. Override will be

placed on the flash drive. Select OK. The device will 

“unlock” anytime this USB drive is plugged into the 

device without the need to enter a password. 

3. Enable or Disable On‐Screen Tools Key, Help Button, 

and/or Pulldown Menu Button.

TAKING A PHOTO 
1. Select Tools>Toolbox>Camera Menu. 

2. Frame the picture and select Take Picture. 

3. Select Save as Icon. 

4. Select OK followed by Cancel. 
Note: The above steps will place the picture in the Imports category 

when you select Change Icon (See #2b under Setup Key). 

SETUP KEY 
1. Be sure you’re looking at the key you want to edit. Select

Tools followed by Setup Key. Touch the key to edit. 

2. Select Change Icon (#1) and either:

a. Spell Icon to Find: spell the start letters for the

icon and select Ok. Touch the icon you want.

b. Select by Category: Look through the categories

for icon. NOTE: camera pictures are in Imports.

3. Look to see if “Text to Speak” is correct. If not, select 

Spell Message or Define Key Function (#2) to type text

that will appear in the text area and be spoken. Be sure

to put a space after the last character. Select OK.
4. Check to see if the label is correct. If not, select Change

Label (#3), type the new label, and select OK.

5. Select OK to exit or Choose Next Key to Define (#4).

CREATING and LINKING PAGES 
1. Be sure you’re looking at the key you want to link to 

the new page. Select Tools, followed by Setup Key, 
and key to link to new page. 

2. Select Change Icon to search for an icon.

3. Select Spell Message or Define Key Function. 

4. Select Clear followed by Page Link and CLOSE.
5. If the page is already created, find and select it from the 

menu; if it is not already created, select Create New 
Page, type the name for the page, and select OK and 

choose a keyboard size 84. Select OK two times.

6. Select Change Label to change the label on the key. 

Labels for page links are typically in all CAPS.

Select OK.
7. Select OK to exit when finished. 

Tools Key 

Power/Sleep 
Button 
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Vocabulary Builder for LAMP WFL 
Accent 800, 1000, 1200, or 1400 (ver. 2.04 or higher) 
LAMP 84 One Hit, Transition, Full Vocabularies 

Vocabulary Builder is a therapeutic tool designed 
to teach new words within the LAMP vocabulary. 
The strategy of “masking” vocabulary allows a 
small amount of vocabulary to be taught on the 
device while keeping learned motor plans constant. 

Vocabulary 

Builder On/Off 

Vocabulary 

Builder Menu 

Toolbox 

Tools 

Key* 

Turn Vocabulary Builder On/Off 

When Vocabulary Builder is ON, a VB will appear 

in the status display. 

1. Select TOOLS key.

2. Select TURN VOCABULARY BUILDER ON/
OFF.

How to create a set of words:

Select TOOLS key. 
Select VOCABULARY BUILDER MENU. 
Select MASK ALL. ** 
Select SPELL TO UNMASK. 
Type the word(s) to unmask using 
commas to separate words. 
Select OK. 
Select OK to exit VB Menu. 

**Skip this step if you are adding words to an 

existing set. 

Active Side When Spelling 

When adding additional words to an existing set, 

to tan. 

Remember to follow the child’s lead! 

Use sequence sets to isolate words you intend to 
teach in structured or one-on-one activities. Add 
or change words frequently as the activity changes 
and turn Vocabulary Builder on/off as needed 
during unstructured time so the individual has an 
opportunity to independently explore. Remember 
to choose words that can easily generalize from 
one activity to another. 

Saving Sequence Sets 
If you intend to keep Sequence Sets you have built, 
you need to SAVE them!! 

Select TOOLS key. 

Select SAVE AS SEQUENCE SET. 
Type the name for the Sequence Set. 
Select OK 2 times. 

Loading Sequence Sets 
After creating a Sequence Set, it can be retrieved 
from the VOCABULARY BUILDER MENU. 

Select VOCABULARY BUILDER MENU. 
Select ADVANCED OPTIONS. 
Select USE SEQUENCE SETS. 
Select LOAD SEQUENCE SET. 
Choose desired set. 
Select OK 2 times. 
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Tools Key 

PASS™ Quick Reference Guide 
Software Version 2.09 or greater 

PASS (PRC Application and Support Software) 

PASS demo software for PRC products allows you to create, 

modify, and save vocabularies, then load them into your 

communication device. You can also use PASS to create 

support materials, such as smart charts, manual boards, and 

vocabulary lists. With PASS, AAC support professionals and 

family members can practice or work on a client’s device 

contents without needing to have the device present. 

Download PASS software for Accent at 
https://www.prentrom.com/support/PASS/download‐ 

nuvoice‐pass‐software 

System Requirements 
Windows Vista®, Windows® 7, Windows 8, Windows 8.1 or 

Windows 10. 

Note: This is a desktop application and will not run on 

Windows RT or in the "Tiles" on Windows 8 or Windows 8.1. 

Most operations and programming in the PASS software 

are exactly the same as on a PRC device. However, there 

are a few differences and some other features. This Quick 

Reference Guide covers PASS‐related topics that are not 

covered in the Accent Quick Reference Guides and other 

language system support materials. 

To learn how to add words, activities, and pages to a 

vocabulary, refer to your device/language system‐specific 

Quick Reference Guide. 

Tools Key (to modify device) 
This key provides access to the user keys, such as the 

Toolbox and Setup key. 

LOADING LAMP WORDS FOR LIFE® (WFL) OR OTHER 
VERSIONS OF UNITY® INTO PASS 
If you are in the Exploration Wizard, follow the prompts on 

the screen to load your desired vocabulary. If not: 

1. Select the Tools key and then Toolbox. 

2. Select User Area Menu. Select Replace User Area.

3. Select a User Area (1‐6) that you want to replace with

a version of LAMP WFL or Unity.

4. Select Pre‐Defined Vocabularies.

5. Select English. 

6. Select the desired LAMP WFL (or Unity, etc.) folder.

7. Select the desired LAMP WFL (Unity, etc.) version (1‐

hit, transition, or full).

8. By selecting Yes, the current user area will be erased 

and replaced with your desired vocabulary. Type the

word “replace”. Select OK.

9. Once complete, answer Yes or No to “Switch to this 

user area now?” Select OK and then Go to Home.

CONFIGURING PASS TO CORESCANNER™, UNIDAD®, 
ESSENCE®, OR WORDPOWER™ 
1. Select the Tools key, select the Toolbox, and then

select Main Menu.

2. Select Change Product Configuration. 

3. Select your desired product configuration. All six

current user areas will be erased and replaced.

4. Select Yes to confirm the replacement. 

5. Select OK twice.

SAVING A VOCABULARY ON A DEVICE/PASS
1. Insert your flash drive into the USB port on the back 

of the device or computer (for PASS).

2. Select the Tools key and then Toolbox. 

3. Select Transfer Memory Menu. 

4. Select Save One User Area and touch the user area

you want to back up or Save Entire Device Contents. 

5. Make sure the pre‐set folder is a USB drive. If so, 

select OK. If not, select Choose Different Folder and

Up Folder to navigate to the USB drive. It may be

marked “Removable media”. Select OK. Type the file

name and date (xx‐xx‐xx).

6. Select OK and wait for the memory transfer to take

place. Once complete, select OK, OK, and then Go to
Home.

LOADING A VOCABULARY INTO YOUR DEVICE/PASS 
1. Insert your flash drive into the USB port on your 

device or computer (for PASS).

2. If loading into PASS, open the PASS software. If

loading into a device, go to step 3.

3. Select the Tools key and then Toolbox. 

4. Select Transfer Memory Menu. 

5. A. Select Load One User Area and touch the user 

area (1‐6) you want to load the vocabulary into. 

Please note, the existing user area will be 

erased/replaced with the new one. 

B. Select Load Entire Device Contents, if you are

loading a file that contains the entire contents of a

device.

6. If you see the file you want to load already on the

screen, select it. Otherwise use Up Folder to navigate 

to the USB flash drive. Select the file you want to load. 

7. Wait for the memory transfer to take place. Once

complete, select OK. Answer Yes or No to “Switch to

this user area now?” 

8. Select OK, OK, and then Go to Home. 

TAKING A SCREEN CAPTURE 
Use the Screen Capture tool to take a snapshot of any 

screen and print it so you can use it as a low‐tech 

communication board. 

To use the Screen Capture Tool: 
1. Navigate to the screen you want to print.

2. Select the Tools menu at the top of PASS.

3. Highlight the Screen Capture feature and click.

4. Name your file and designate where you want the file

saved on your computer.

5. Select Save.

 

Screen Capture 
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6. You will now see a Paint Program or equivalent 

editing software open with your page displayed. 

7. Format and print.

WRITE WITH ICONS (WWI) 
FOR UNITY AND LAMP WFL ONLY 
Write with Icons allows you to type words and see them 

displayed as icon sequences. WWI works with Unity and 

LAMP WFL. For example, if your PASS is in a user area with 

Unity 84 Sequenced, WWI will display icon sequences for 

words in Unity 84 Sequenced. People use Write with Icons 

to make support materials such as flash cards, target 

vocabulary lists, and adapted classroom materials. 

To use Write with Icons: 
1. Select the Vocabulary Tab.

Note: If this is your first time using PASS, you will see a 

WWI setup screen. You can use this to change how WWI 

works (see WWI Preferences). To skip this screen in the 

future, uncheck the box marked “Show set-up at Write 

with Icons start-up”. Select OK. The display will change to a 

tan background with WWI instructions on the top of the 

screen. 

Now whatever you type will show up on the display with 

icon sequences. You must type a word and then add a 

space, tab, return, or punctuation after it to display the 

icon sequences. 

To format and print your words and icon sequences, select 

File, then Save and Open. Name your file and designate 

where you want the file saved on your computer. Then 

select Save. Your words and icon sequences will open in a 

text document. Format and print. To stop using WWI, 

select Vocabulary and then Return to Emulator. 

WRITE WITH ICONS PREFERENCES 
To change WWI options, go to the File Menu and select 

Preferences. 

Instructions on Page: 

Icon on Key Background: 

Icons Only (no typed words): 

Icon Sequence Choices: With Icon Sequence Choices ON, 

you will be given choices if there is more than one way to 

say a word. Click on the sequence you want, and then 

select OK. With Icon Sequence Choices OFF, you will get 

the first choice on the list. 

Automatic Phrase Handling: With Automatic Phrase 

Handling OFF, each word will show its sequence. 

With automatic phrase Handling ON, the shortcut phrases 

will be displayed. 

CREATING A SMART CHART 
A “Smart Chart” is a support material created from a set of 

words using Vocabulary Builder. Vocabulary Builder is a 

therapeutic tool that allows you to temporarily limit the 

amount of vocabulary visible. 

To learn more about Vocabulary Builder for Accent 

products, visit 
https://www.prentrom.com/training/courses/vocabulary_builder 

For LAMP Word for Life, visit our PRCaccess channel on YouTube. 

To create a Smart Chart: 

1. Have Vocabulary Builder turned on with your desired

set of words visible.

2. Select the Vocabulary menu at the top of PASS.

3. Select Vocabulary Display Options. 

4. Select Create Smart Chart.

5. Your Vocabulary Builder set of words will be displayed

as a list of words and icon sequences in Write with

Icons.

6. Select File, then Save and Open. Name your file and

designate where you want the file saved on your

computer. Then select Save. Your words and icon

sequences will open in a text document. 

7. To turn your list into a chart, in Word, highlight all

text and icons.

8. Select Insert.

9. Select Table. 

10. Select Convert Text to Table. 

11. Select OK and a chart will be automatically created. 

LOOK UP ICON RATIONALES 
1. Select the Vocabulary menu at the top of PASS.

2. Select Vocabulary Display Options. 

3. Select Core Key Assignments. 
4. Hover over an icon with your mouse or scroll down

the page to view icon rationales. 

2. Select Vocabulary Display Options. 
3. Select Write with Icons (F11). 

14

https://www.prentrom.com/training/courses/vocabulary_builder
https://www.youtube.com/watch?v=y6ItaOORbro&list=PLeOTpEi0oXbh3MrtEyhrH9xvMXwe2AZTc&index=4


Touch Access Quick Reference Guide 
for NuVoice® Software 
Support: (02) 9124 9945
support@liberator.net.au 
www.liberator.net.au 

STEP 1 – SET ACCESS METHOD TO TOUCH 
1. Select Tools, then Toolbox. 

2. Select Access Method Menu. 

3. Select Choose Different Access Method. 

4. Select Touch. 

STEP 2- KEYGUARDS AND TOUCHGUIDES 
Attach any recommended keyguards or TouchGuides to the 

device. See the instructions that came shipped in the box. If 

no keyguards or TouchGuides, go to step 3. 

Keyguards: A keyguard fits in a frame and isolates each key 

to help increase accuracy and speed. Keyguard holes are 

typically square. A keyguard can be flipped up from the 

bottom. 

TouchGuides: A TouchGuide lays flat on the screen and 

isolates each key to help increase accuracy and speed. 

TouchGuide holes are rounded. TouchGuides cannot be 

flipped up. 

Keyguard TouchGuide 

STEP 3 - OBSERVE PERFORMANCE 
Observe the user’s performance while using the factory 

defaults and any recommended keyguards or 

TouchGuides. This information will help you decide if 

adjustments to the touch screen are necessary. Note any 

difficulties. 

 STEP 4 – ADJUST SETTINGS
There are a variety of settings that can be adjusted to 

change how and when the screen reacts when touched. 

The following is an explanation of settings available in the 

Access Method Menu. 

ACCEPTANCE TIME [DEFAULT = .01] 

Acceptance time is the amount of time you need to 

touch the key until it activates (.01 to 5.0). Typically, 

the acceptance time is increased if miss hits are 

observed. 

RELEASE TIME [DEFAULT = .01] 

Release time is the amount of time the key will 

remain depressed (.01 to 5.0). Subsequent selections 

on the key will be ignored. Typically, the release time 

is increased if double hits on the same key are 

observed. 

ACTIVATE KEY WHEN [DEFAULT = Pushed] 

Pushed: A key will activate when pushed. 

Released: A key will activate when the finger (or 

stylus etc.) is taken off the key. This allows a user to 

drag a finger across the screen and release when the 

desired key is reached. 

AUTO REPEAT 
[Default = OFF] When turned ON, a user can select the same key 

multiple times by maintaining touch on the key for the selected 

period of time (without having to move off of the key and then back 

to it again). This is especially helpful when using Unity® Sequenced or 

LAMP Words for Life® Transition/Full vocabularies. Adjust with the 

arrows. A typical auto repeat time matches your dwell time. 

 PREDICTIVE SELECTION
[Default = ON] When turned ON, if the user selects a blank key 

nothing will happen. Blank keys are inactive. This is especially 

helpful when using Unity Sequenced or LAMP Words for Life 

Transition/Full vocabularies. 

WINDOWS® ACCESS SETTINGS 
Windows Clicks 
ON allows for mouse clicks in Windows. 

Magnify Windows Clicks 
ON provides an on-screen magnification pane in Windows 

with a click. Magnification is helpful when accessing small 

targets. 

1. Magnification Factor: Ranges from 2 to 5 times

magnification. Use the arrows to adjust magnification

power.

2. Magnification Area: Ranges from 64 x 64 to 256 x 256. 

Use the arrows to adjust magnification pane size.

ADDITIONAL SETTINGS IN THE TOOLBOX 

VISUAL FEEDBACK 
Provides an inverted flash when a key is selected. 

1. Select Tools, then Toolbox. 

2. Choose Feedback Menu. 

3. Choose Skin Options. 

4. Turn Key Visual Feedback ON/OFF.

KEY PADDING 

Provides additional space around each key. 

1. Select Tools, then Toolbox. 

2. Choose Feedback Menu. 

3. Choose Skin Options. 

4. Set Key Padding (1-20). The larger the number the

more space around each key. 

Tip: When acceptance or release time needs to be 

adjusted, increase the time by .10 and then observe 

performance. If miss hits or double hits are still 

occurring, adjust the time again by .10. Do this until 

the setting is just right for the person. 
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Realize Language is an online service that gives parents and professionals powerful ways to monitor, 
measure, and maximize a child’s use of an Augmentative and Alternative Communication (AAC) 
speech device. 

The Accent, NovaChat and Liberator Rugged devices can automatically collect data when being  used. 
Realize language can analyse and present this data in a visual format. 
Realize language can: 

• Track progress and communication development over time
• Automatically compare different aspects of communication
• Create a detailed dashboard summary of performance
• Share information with everyone on the team
• Quickly create valuable reports that anyone can understand, even those with limited

knowledge of AAC

Realize language has a free 30 day trial period which can be used during device trials: 
https://realizelanguage.com/info/ 

Every new Liberator device purchase comes with a free 1-year subscription to Realize 
Language. 

Contact your local Liberator consultant for assistance and guidance in using Realize. 
https://liberator.net.au/liberator/contact-liberator 
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